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About Flip PDF 

Flip PDF is your easy way to batch convert ordinary 

PDF files into stunning booklets with amazing 

page-flipping animations and sound! Imagine 

being able to create digital magazines and 

catalogues that behave like actual paper books 

without any programming work! Once you've 

created your page-flipping masterpiece in Flip PDF, 

you can publish it to the web with FlipBuilder 

Upload Service, via email, and even distribute it on 

CD-ROM, all without paying royalties! 

 

 

 

 

 

 

 

 
 

Note: This product is distributed on a "Try 

before-you-buy" basis. All features described in this 

documentation are enabled. The registered version 

doesn't insert a watermark in your generated 

page-flipping eBooks. 
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Product features 

1. Convert PDF to Adobe©  Flash® based page-flipping eBooks. 

2. Offer Project Panel to easy open or save project. 

3. Batch convert multiple PDF files to a single or multiple page-flipping eBooks. 

4. Import bookmarks (outline/table of content) with PDF. 

5. Import hyperlinks with PDF, include web link, page link, email link. 

6. Import text so text is searchable, define the minimum search characters. 

7. Add watermarks text, image, dynamic date/ time etc to page-flipping eBooks. 

8. Define quality and size for normal version and mobile version. 

9. Detect landscape page to present as two-page spread. 

10. Publish online directly with using FlipBuilder Upload Service. 

11. Output to different formats: HTML, EXE, Zip, Mac App, Mobile version and 

Burn to CD. 

o HTML allows you to upload to a website to be viewed online (with title, 

keywords and other metadata defined). 

o EXE (with setting title, icon and open window size) and Zip allow you to 

send to your user by email to be viewed on their computer. 

o App (Mac Application) is executable application can be run on Mac. 

o Mobile version is to output HTML flipbook which can be viewed on mobile 

devices via Browsers (Support slide single pages on mobiles). 

o Burn to CD allows you to burn to disk so you can send your user physical 

media for viewing on their computer. 

12. Show uploaded books in BookCase with shopping cart integrated. 

13. Apply a pre-designed template and animated scene, more free templates online. 

14. Show Assistant and scrolling tips in your book, and record or embed sound directly. 

15. Preview the output effect instantly. 

16. Add HTML Title in Float template which can be clicked to visit webpage 
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online. 

17. Add Image or Flash logo to insert before Book Title in Float template. 

18. Define book proportions, thickness, margin size, shadow manually. 

19. Set background color and image. 

20. Insert background music either for continuous play (loop) or for a set 

duration. 

21. Set eBook reading from right to left (for Right-to-Left languages such as 

Arabic). 

22. Choose hard cover for eBooks. 

23. Set fonts for Flash and Bookmark, Search panel. 

24. Define the language for your published page-flipping eBook (support 

multi-language show and switchable). 

25. Add password to protect your page-flipping eBook. 

26. Different kinds of render engine for choice to avoid distortion for some 

special PDF files: SWF, GPL Ghostscript or Inner Library.  

27. Google Analytics Support. 

28. Set colors and position (Top/Bottom) for toolbar. 

29. Set permissions for downloading, printing, social sharing, Home button and 

more. 

30. Add watermark image or SWF to show on print out pages. 

31. Add Help config to manually define content with using Image or SWF. 

32. Set Page Number Box to show at top or bottom in Float, set start page 

number. 

33. Add Single/Double Page view. 

34. Add Minime Style to show page-flipping eBooks without toolbar. 

35. Edit bookmark and set bookmark panel to show on left or right side. 

36. Export and save settings for future uses. 
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Page-flipping eBook features 

With the page-flipping ebook you have created, your user will be able to: 

1. Flip book pages by dragging corner, clicking page shadow, mouse wheel, etc.. 

2. Use Previous, Next, First or Last buttons or thumbnails to navigate through the pages. 

3. View with important pages pre-loaded to open quickly, no need to wait for all pages to 

be loaded. 

4. Flip pages automatically. 

5. View page-flipping eBook in full screen. 

6. Add annotation text or shapes to highlight.  

7. Print out the whole eBook or a selected range of pages. 

8. Download uploaded page-flipping eBook or other file while reading book. 

9. Double-click to zoom in or zoom out. 

10. Share eBook URL via email, Facebook, Twitter, Google, Yahoo, etc. 

11. Turn background sound on/off. 

12. Open in the Browser to a specific page by adding a page index to your URL. E.G. 

www.yourdomain.com/index.html?pageIndex=4. 

13. Always show in Minime Style with adding a parameter to URL. E.G. 

www.yourdomain.com/index.html?alwaysMinimeStyle=true. 

14. View page-flipping eBooks in the browser of Mac, PC, iPad, iPhone and Android devices. 

 

 

 

http://www.yourdomain.com/index.html?pageIndex=4
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Quick Start 

1. Launch the application via the desktop shortcut ; 

2. Click "Create New" and select template and define project path; 

3. Select PDF to import and click "Import Now" icon  to enter into template 

setting interface; 

4. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and then click the 

"Apply Change" icon ; 

5. Click "Upload Online"  or "Convert to Flipping Book"  to output 

created page-flipping eBook. 

Interfaces 

There are some main interfaces you will see while using Flip PDF as 

below shows: Project Panel, Application Options, Import PDF, Template 

Settings, Language Option, Output, Upload Online and Batch Convert. 

You can enter into each page to get clear instructions for every detail 

option. 
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I. Project Panel 

 

In the project control panel, you can view and open recent projects and output flipbooks, create 

new project or just view demo project. Besides, you can view BookCase Demo, check Online 

Service details, get support, view "About" and "Update" info. 

 

II. Import PDF Interface 

Chick "Create New" to build your own project, select template, define project name and location. 
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You can select Template and Theme from the list, or go to "Online Templates" panel to download 

more templates and themes to use in Flip PDF. More templates and themes online: 

http://www.flipbuilder.com/templates-themes/index.html . 

 

Then click "Next" to enter into PDF Import interface: 

 

1. Source PDF File 

 Click this icon to open the PDF file you want to convert; 

 View content of added PDF file to clarify before converting. 

2. The Page Ranges to Import 

 Convert all pages to page-flipping eBook; 

Convert defined range page; 

 Just preview effect on first 10 pages. 

3. Watermark 

 Add image or text watermark to flipping pages. 

Check this option first to choose default stamps or add new ones: 

http://www.flipbuilder.com/templates-themes/index.html
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4. Page Quality 

There are five types of "Quality And Size": 

 

5. Other Options 

Check this option to import bookmarks from PDF to use in output eBook; 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook; 

Check this option to make landscape page in PDF file to be presented as 

two-page spread in output flipbook. 

 

At last, click  icon to enter into template setting interface. 
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III. Template Settings Interface 

 

After importing PDF, you will see the main Template Design and Preview interface. Four tabs in 

the design panel for you to design template, choose scene, define bookmark and edit content for 

assistant.  

 

1. Design Setting 

 

The design setting interface contains below main parts: 

Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings. 

(1). Choose Template 
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Although you have selected template before importing PDF, you can also change to other 

templates. Just click  icon to select templates from Template Selection 

interface, or download Online Templates to use. 

Click this icon is to save current settings as a TXT file for later uses; 

Click this icon is to import stored setting file at once. 

Download more templates/themes to use: 

http://www.flipbuilder.com/templates-themes/index.html . 

 

(2). Tool Bar Settings 

 

i. Title Bar (only in Float and Neat template) 

 

Customize book title and logo for showing on the top of your flipbook. You are enabled to set the 

book title as HTML format text. For example: <a href='http://www.flipbuilder.com' 

target='_blank'>FLIPBUILDER.COM</a> | <font color='#ff0000' size='14'>Red Color</font> 

 

ii. Buttons Bar 

 

 

http://www.flipbuilder.com/templates-themes/index.html
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Home Button 

You can add a home button  to help reader to click and go to your website directly: 

 

Full Screen Button 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button" 

option:  

Then you can click icon  to view flipbook in Full Screen, click icon  or "Esc" button 

to exit from the Full Screen. 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you 

can set "No" in "Full Screen without Tool Bar" (just in Classical Template): 

 

 

Help Config 

 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you can 

define Help Content manually by inserting "Help Content File (image or SWF)", also enable to 

define the Width and Height of the Help image or swf. If you set "Book->Retain the book to 

center->No", you can set "Show Help At First->Show" to display the Help Panel with the Book as 

below: 

 

You can also click the button  to view the same Help page in pop-up window. 
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Print Config 

 

Choose "Yes" in "Print Enable", then click icon  to set print page range as below: 

 

You can also click "Print Watermark File->…" button to choose image or SWF file from your 

computer as watermark on printed out pages. 

 

Download Setting 

  

If you want your flipbook readers to download the PDF file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input Download URL directly like 

"http://www.flipbuilder.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or relative 

path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the PDF to the 

same path).  

Then readers can click the icon  to download your uploaded PDF file directly. 

 

Sound 

 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer, then 

set "Sound Loops", "-1" stands for playing the sound file all the time while viewing flipbook, 

other value (N>0) stands for the times of playing the sound file. 
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Zoom Config 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 

 

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by the 

zoom in tool like this: . You can also set "Scroll with 

mouse->Yes" to scroll zoom in page while moving mouse. 

 

Search 

 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import 

PDF" interface), then define "Search Highlight Color", after clicking "Search" icon , you 

will see a popup box to input search words, then click Enter or "Search" button, you will get the 

below searching result: 
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Share 

 

a. Share Button (via Email) 

If you want readers to share via Email, you can enable "Share" feature as below shows: 

 

When the viewers click the share button , they will enter into the Email interface with the 

link of your flipbook in the Email body. 

 

b. Social Share 

If you want your flipbook viewers to send the link to their friends or clients via Facebook, Twitter, 

Linkedin, Google, Yahoo and so on, you can add a Social Share button in your flipbook for readers 

to send out your flipbook link immediately: 

 

The readers just need to click the "Social Share" button , then the below window will pop up 

for them to choose share channel: 

 

 

Auto Flip 

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip 

Interval (seconds of staying on each page); the value of "Play Count" stands for the times of auto 

playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip button , 

the flipbooks will be flipped by staying 3 seconds per page); if you want to auto start and flip the 

eBook after opening, just set "Auto flip when start up->Yes": 
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Thumbnail Button 

 

Show Thumbnail Button (set "Enable") to view page thumbnails of your book, or you can 

Disable it to hide the button. 

 

Single Page 

 

If your book contains landscape pages, or the page content is different to read for the font is too 

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon  to 

view pages one after another, then click "Double Page" icon  to back to the normal book 

reading mode. 

 

Language 

 

You can set language for showing tools or tips in your created flipbook, click "…" to enter into 

"Language Settings" interface. You can choose two or more language to use, just check 

"Switchable" option, then users can click "Switch Language" button to choose their prefer 

language for tips: 

 



PDF to Page-Flipping eBook Utility 
 

User Document 

Copyright 2013 by FlipBuilder.com 
- 16 - 

 

Add Annotations 

To help readers take notes on your books while reading, you can set "Add Annotation->Enable". 

When readers view your book on computer, they can click "Add Annotation" icon  to add 

text note, highlight pages with brush, draw rectangle or ellipse on anywhere of your book pages. 

If they open the book next time, they can view the comments, or delete as they want: 

 

 

iii. Tool Bar on Top (only in Float template) 

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

"Tool Bar on Top" as "True": 

 

iv. Button Icons 

Define color for the icons of the buttons: 
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(3). Flash Display Settings 

 

i. Retain the book to center 

 
If you select "No" in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log. 

 

ii. Pages per thickness (only in Neat template) 

To create more real life like ebook, you can set Pages per thickness, which means how many 

pages to show a distinguishable thickness. The smaller value set, the thicker your book. If the 

value is smaller than 0, or larger than the total page number of your book, it won't show any 

thickness. And on the book edge, you will see different page number tips for you to click and go 

to that page directly: 

 

iii. Background Alpha 

 

Set the value (0-1) of alpha to control the transparence of the background in flip book. For 

example, you can set the value as 0 to make the book background as transparent completely, 

when you embed the book in other HTML page, it will show the background of that HTML only. 
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iv. Show Corner Flip Effect 

Show the Corner Flip Effect at the beginning to tell readers that they can drag or click the corner 

to turn pages directly. 

 

v. Mouse Tracing Effect 

Show Mouse Tracing Effect at the beginning to tell readers that they can drag or click the corner 

to turn page. If the book is set to open with double page spread, then the Mouse Tracing Effect 

won't work. 

 

vi. Open thumbnails pallet 

Define whether the thumbnail pallet open or not when you arrive on the book. 
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vii. Font 

 

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search result 

panel, you can set font types and colors in Font Panel.  

 

viii. Initial Show (set in Float/ Spread templates) 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 
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ix. Background Config 

Background Color:  

 
Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors. 

Background Image (set in Classical and Spread templates): 

 

Click the icon " " to choose background image from your computer, and there are 11 kinds of 

"Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, 

Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

 

Background Image (set in Float template): 

 

The Float template enables you to add two background images: Outer Image and Inner Image. 

You can make Inner background image to show special information, such as advertisement or 

company logo, etc. There are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill, 

Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle Right, Bottom Left, Bottom 

Center and Bottom Right. 
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x. Flash Window Color 

 

This color will be applied on all flash windows, such as the book window, "Help" window, "Print" 

window and so on. 

 

xi. Page Background Color 

 

When load pages, or if the page number of your PDF file is odd, then the page (the last page) will 

show with the "Page Background Color". 

 

xii. Book Proportions 

 
Please note that the values are not fixed in pixels or inches, they just represent a ratio for "Page 

Width: Page Height", and the book size will be changed depend on your Explorer Window Size. 
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xiii. Book Margins 

Book Margin (set in Classical Template): 

 

"Book Margin" refers to the distance between the book and the toolbar. 

Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 

 

 

xiv. Page Shadow 

 

The value also takes the value of Book Proportions as reference, and the value interval of "Page 

Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color. 

 

xv. Hide Book Frame Bar 

 
If don’t want to show the book frame bar, choose “Yes” in this option. 
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xvi. Right to Left 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right 

to Left" option: 

 
 

xvii. Start on Double Page 

Open your book in double-page spread or not. "Yes" means open book without cover, presenting 

first two pages at a time. If you have odd number pages, you can set this option as "Yes". 

 
 

xviii. Hard Cover 

If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook, 

choose "Yes" in "Hard Cover" option: 

 

 

xix. Flipping time 

 
Sets page flipping time in seconds according to your needs. (Recommended value is 0.6) 
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xx. Mouse Wheel to Turn page 

 
Enable or Disable turning page with mouse wheel. 

xxi. Page Number 

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". For 

example, the first 3 pages are Table of Content pages with Roman page numbers, and set Arabic 

page numbers from page 4, then you will get page number box like below: 

 

xxii. Minime Style 

If you want to present Page-flipping eBook pages directly without showing toolbar, especially 

when you want to embed eBook into a small area in existing webpages, then you can use this 

"Minime Style". The Minime Style will trigger when the Width or Height of the Flash Container is 

less than the defined value. You can also always show the page-flipping eBook in Minime Style 

with adding a parameter to your URL like this: 

www.yourdomain.com/index.html?alwaysMinimeStyle=true . 
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(4). Flash Control Settings 

 

 

i. Security Settings 

 

If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 

 

Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All Pages" 

or the latter pages after a defined page number. (Tips: The program utilize RC4 algorithm to 

protect eBook pages, the eBook content pages will show nothing without permission.) 
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ii. Links 

 

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page" 

interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers to 

the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), and 

"Open Window->Blank/ Self". The links also can be clicked after zooming by setting "Enable after 

Zooming in->Enable". 

 

iii. Google Analytics  

In the HTML output format, you can add statistics by using google analytics. You can get more 

information about Google Analytics ID from http://www.google.com/analytics/ . 

2. Scenes Setting 

 

To make your book more attractive and lively, you can apply animated background which 

called "Scene" in the flip program. There are many pre-designed scenes for you to choose 

and use directly, such as Autumn Leaves, Beach Beauty, Desert, Moon, Underwater World, 

Grassland, Snow, Clouds, etc. 

 

http://www.google.com/analytics/


PDF to Page-Flipping eBook Utility 
 

User Document 

Copyright 2013 by FlipBuilder.com 
- 27 - 

 

 
Just double-click to apply the scenes, or you can set your own style scene by setting "SWF" 

format background image in "Design Setting" part. 

 

3. Bookmark Editing 
 

You can check "Import Bookmarks" option in Import PDF interface if your PDF contains 

bookmarks, or you can edit bookmarks directly in the program. In Classical Template, you 

can even define bookmark font color, background color, position, etc.: 

 

4. Assistant Setting 
 

If you want to provide sound or text tips for pages of your books, you can enable the Assistant 

Feature, edit scrolling text, record audio or insert sound directly. Then readers can following your 

tips, listen to the audio you applied, get more interest and info from your book. 
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Click "Record & Manage Audio Files" icon to enter 

into Record Audio interface: 

 

Input "Audio Text" for each page, and then choose Text-to-Speech engine, and then click 

"Generate audio". After generating, you can click "Play audio" to listen to the audio, you can 

also choose "Import audio from existing file" to apply existing audio directly. 
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About Text-to-Speech engine install and use, you can view details in this page: 

http://www.flipbuilder.com/support/how-to-read-your-text-to-readers-in-flipping-book.htm  

 

5. Other Settings 

(1). Export Theme 

If you want to save the current template settings as your own style template for later uses, you 

can click "File->Export current settings as Theme" button to storing all current template settings, 

include the background images, margin values, toolbar buttons and so on. 

Then when you want to use later, just click "File->Import Themes", the theme will be added to 

the templates selecting interface. Download more themes from FlipBuilder now: 

http://www.flipbuilder.com/templates-themes/index.html . 

 

(2). Application Options 

i. Render Engine Option 

Flip PDF Pro provides 3 different render engines for you to create higher quality page-flipping 

eBooks, click "Options->Application Options" to enter into "Render Engine" interface: SWF: Much 

legible characters, smaller output size; GPL Ghostscript: Higher color transfer quality; Inner 

Library: Faster convert speed (change option when PDF imported failed). 

ii. Create Mobile Version Option 

Pages Quality and Size 

Five types of "Pages Quality And Size" for mobile version eBooks: 

 

Mobile Template 

The current version provides two mobile template modes for you to use: Slide and Single Page 

Flip. The later one adds page-flipping effect on the pages while viewing in mobiles. 

 

At last, click  icon to apply the settings. 
 

IV. Language Options Interface 

Click "Option->Flash Language" or "…" button beside Language setting part, you will enter 

http://www.flipbuilder.com/support/how-to-read-your-text-to-readers-in-flipping-book.htm
http://www.flipbuilder.com/templates-themes/index.html
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into the Language Settings interface as below shows: 

 

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you 10 different languages for you to use: 

English, Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese. 

You can also add other language for your own uses: 

1. Click the button  and define name for the new language: 

 

Click "OK" to save the new language in the list; 

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save And Edit Next": 
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3. At last, you can get all Labels translated into your new language as the images shows: 

 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  

After setting language, click  icon to apply settings. 

V. Upload Online 

To make it easier for you to publish your created flip page books online, we developed the 

Upload Online Service. By using this service, you can upload your book online instantly after 

creating it, with no FTP or other upload tool needed. You can easily manage your books, and 

make it easy for people to view your books online in their browser on their PC, Mac, iPhone, iPad 

and Android devices. 

After designing your book style, you can click "Upload Online" button to 

upload your book onto FlipBuilder website server directly. Upload the books to FlipBuilder.com 

server, just need 3 steps: Sign up, login your account, upload your books. 
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1. Sign Up 

Create your account to use the Upload Service easily: 

 

2. Login Account 

After registration successful, you will login automatically. 

 

3. Upload Your Book 

After login your account, just input your book HTML title and then click "Publish Now" to 

upload your created book. You can also define Description and create mobile version in 

"More": 

 

After uploading successfully, you can use the Book URL to share with others online, or 

through social share websites, or copy the Embed Code to insert into webpages in "Book 

Information" panel, etc. 
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You can click "Manage Online Books" button in main process 

interface to manage your uploaded in below window: 

 

In the book manage window, you can check your publications, share them with others, edit 

book info, hide your book to prevent other people from reading your book, even delete it if 

you want to edit again. 

 

You will get 5 free points after registering, and a point can be used to upload a book within a 

month. You can purchase more points to use based on your needs, and more points 

purchase at a time, you can get order with more discount. 

 

Within 24 hours of the first start service for each book will not charge, and a point will be 

deducted after the 24 hours. If you delete or disable the book within the month, the service 

center will stop charging you in later months, or if you enable the book again in the same 

month, you won't be charged again. Should be noted that, if you disable the books within 

the first 24 hours, the system won't charge, but if you enable the books in the period after 

this 24 hours, the system will immediately charge points. And once your surplus points are 

not enough to pay for all books service, the system will enable related number of books, but 

disabled the other ones. 

 

There is another charge method if you have dozens of even hundreds of books to upload a 

month, monthly charge $9.99 to upload 1000 books a month. You can transfer to VIP User to 

pay monthly in the "Account Info" panel of online manage page: 

http://panel.flipbuilder.com/userLoad/accountInfo.php . 

 

More FAQs about Upload Service: http://panel.flipbuilder.com/userLoad/faq.php . 

http://panel.flipbuilder.com/userLoad/accountInfo.php
http://panel.flipbuilder.com/userLoad/faq.php
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VI. BookCase 

Flip PDF BookCase integrated in Flip PDF will be the best tool to help you build digital 

library to store and manage eBooks. All books you published on FlipBuilder Server or 

some other place online can be collected and shown in your bookcase, you can easy 

manage and share the books via using the wonderful and realistic BookCase tool. 

 

More details about how to use and design BookCase here: 

http://www.flipbuilder.com/bookcase/manual/index.html   

 

VII. Output Interface 

Click "Convert to Flipping Book" to enter into output interface: 

 

http://www.flipbuilder.com/bookcase/manual/index.html
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1. HTML 

 
This output type is for uploading created page-flipping ebook onto websites. You can define 

HTML Title and other properties by clicking "Advanced" button. Set Keywords, Description or 

even Script in the below interface: 

 
 

2. ZIP  

 
This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon. Your recipients just need to uncompress the ZIP file and then they 

can view the HTML flipbook instantly: 

 

 

3. EXE 

 
This type is for outputting flipbook as a single executive file, easy storing and easy viewing:  
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You can also define Icon and Opening Window Size in Advanced Settings: 

 
 

4. APP 

 

If you want to make executable application to run on Mac devices, you can output as 

"*.app" format. 

 

 

5. Mobile Version 

 
You can even output Mobile Version while choosing HTML or ZIP format at the same time. 

After creating mobile versions, you just need to output all files online (including HTML, SWF, 

"files" and "mobile" folders), then you can visit the flipbook page through your mobile 

browser.  

 

6. Burn to CD 

 
After choosing output type, check option "Burn to CD", set "CD Writer", define "Disc title". 

 

"How to make created eBooks available for others online", view details in this support page: 

http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm . 

 

At last click button to output flipbook in your defined type. 

http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm
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VIII. Batch Convert Interface 

Click "Convert->Batch Convert" to enter into batch process interface: 

 

1. Add PDF Documents 

Click this icon to add PDF files from computer; 

 Click this icon to add all PDF files in the folder (include sub-folders). 

 

You can also remove some unwanted PDF, move up/ down files, or clear all documents.  

 

 

2. Settings 

(1). Output Settings 

  i. Choose Output Type 
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  ii. Choose Output Path 

 
 

You can also define output name pattern with FileName, Title, Subject and so on: 

 
 

And after defining the File Name, you can preview the result example below: 

 

  iii. Define Output Option 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 

 

  iv. Merge All PDF Files to One Flip Book 

 

(2). PDF Settings 

  i. Page Range 

 

You can convert "All pages" or just "Custom range"; 
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  ii. Watermark 

 

Click "Set Watermark" icon to enter into "Watermark" interface: 

 

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add 

Text Watermark, Add Image Watermark, Delete, Move Down/ Up. 

  iii. Page Quality 

 

Choose quality and size type from listed five kinds. 

  iv. Other Options 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

3. Convert 

Click  icon to batch convert listed files together. 
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License Agreements   

 

All copyrights to Flip PDF (the Software) are exclusively owned by FlipBuilder.com. For more 

information, visit our website at www.Flipbuilder.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by A-PDF Solution. 

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

  

 

http://www.flipbuilder.com/


PDF to Page-Flipping eBook Utility 
 

User Document 

Copyright 2013 by FlipBuilder.com 
- 41 - 

 

How to Order 

 

Order Online (http://www.flipbuilder.com/flip-pdf/index.html) or Order Toll Free 

1-877-353-7297 (When you order toll free just give the operator the product number of the 

product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 

 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  

 

Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 

 

 

Want to custom the program or have other questions about purchase? 

Contact us at support@flipbuilder.com . 

 

 

 

mailto:alice@flipbuilder.com


PDF to Page-Flipping eBook Utility 
 

User Document 

Copyright 2013 by FlipBuilder.com 
- 42 - 

 

Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you don't get a satisfying solution, please 

contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

http://www.flipbuilder.com/support/list-Flip-PDF  

 

2. Learn tutorial about Flip PDF 

We publish a video tutorial which shows you the easy procedure of dealing with Flip PDF, you 

can view this video to quickly handle the stunning tool:  

http://www.youtube.com/watch?v=O0TAtCq3ceI&feature=player_embedded  

 

3. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 

obtain the invoice.  

 

4. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@flipbuilder.com, we will respond you ASAP. 

 

 

 

http://www.flipbuilder.com/support/list-Flip-PDF
http://www.youtube.com/watch?v=O0TAtCq3ceI&feature=player_embedded
http://www.regnow.com/cs/orderStatus
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